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1 Revision History

The revision history describes the changes that were implemented in the document. The changes are
listed by revision, starting with the current publication.

1.1 Revision 4.0

Added Appendix 2: Running the TCL Script, page 28.

1.2 Revision 3.0

The following is a summary of the changes made in this revision.

*  Updated the document for Libero SoC v12.2.
* Removed the references to Libero version numbers.

1.3 Revision 2.0

Updated the document for Libero SoC v12.0.

1.4 Revision 1.0

The first publication of this document.
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Common Public Radio Interface Demo

Figure 1«

The Common Public Radio Interface (CPRI) is an industry standard which defines the publicly available
specification for the key internal interface of radio base stations between the Radio Equipment Control
(REC) and the Radio Equipment (RE) as shown in following Figure 1, page 2. Microsemi provides the
CPRI slave IP core that implements the transmitter and receiver interfaces of the CPRI standard. These
IP cores are easy to integrate with CPRI-based data converters to develop high-bandwidth applications.
Microsemi CPRI IP supports from line rate1 (614.4 Mbps) to line rate 7 (9830.4 Mbps). The transceiver
supports link rate from 250 Mbps to 12.5 Gbps per lane. The transceiver supports up to line rate 9 for
CPRI protocol. The transceiver (PF_XCVR) module integrates several functional blocks to support
multiple high-speed serial protocols within the FPGA.

Radio Base Station System

Network

Interface

Radio Equipment
Control(REC)

C&M Sync IQ
Layer2

Radio Equipment
(RE)

C&M Sync IQ

Layer2

Air Interface
>

E@

Master Slave

CPRI Link

This demo design is created using the PolarFire high-speed transceiver blocks and CPRI Slave IP core.
The design operates in the loopback mode by sending the CPRI Master data to the CPRI Slave IP core
through the transceiver lanes, which are looped back on the board. This loopback setup facilitates a
standalone CPRI interface demo that does not require CPRI testers and other devices to validate the
design.

The demo design shows CPRI loopback using transceiver on the Evaluation board. The CPRI Slave IP is
configured at:

* Line Rate 5: 4.9152 Gbps

*  Number of Antenna Carriers: 4

*  The Transceiver is configured in 8b10b mode running at 4.9152 Gbps data rate.
*  32-bit PCS fabric interface using a 122.88 MHz reference clock.

Microsemi Proprietary DG0843 Revision 4.0 2
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2.1 Design Requirements

The following table lists the hardware and software requirements for running the demo.

Table 1+ Design Requirements

Requirement Version

Operating system Windows 7, 8.1, 10

Hardware

PolarFire Evaluation Kit (MPF300-EVAL-KIT) Rev D or later

Software

Libero SoC Note: Referto the readme. txt file provided in the design

files for the software versions used with this

FlashPro Express ;
reference design.

Note: Libero SmartDesign and configuration screen shots shown in this guide are for illustration purpose only.
Open the Libero design to see the latest updates.

2.2 Prerequisites

Before you begin:

1. For demo design files download link:
http://soc.microsemi.com/download/rsc/?f=mpf_dg0843_df

2. Download and install Libero SoC (as indicated in the website for this design) on the host PC from the
following location:
https://www.microsemi.com/product-directory/design-resources/1750-libero-soc#downloads

3. Download and install the SoftConsole on the host PC from the following location:
https://www.microsemi.com/product-directory/design-tools/4879-softconsole#tdownloads

2.3 Demo Design

The PolarFire CPRI Loopback demo design is developed for demonstrating CPRI IP in Slave mode. The
pattern generator in this demo design generates CPRI protocol data such as 1Q data, VSS data, Ethernet
data, and Antenna carrier control data which is provided to the CPRI master module. The CPRI master
module frames the data according to the CPRI protocol. The generated frames from CPRI master are
loopbacked to CPRI slave IP using the XCVR. The CPRI slave IP unpacks the incoming data into 1Q
data, VSS data, Ethernet data, and Antenna carrier control data. This data is then loopbacked from CPRI
slave IP to CPRI master module, therefore demonstrates Full duplex transmission of CPRI IP in Slave
mode.

Microsemi Proprietary DG0843 Revision 4.0 3
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The following figure shows the top-level block diagram of the CPRI demo design.

CPRI Demo Design Block Diagram
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The following steps describe the data flow in the demo design:

-

o

10.

1.

12.

13.

The Mi_V_module configures the registers of the CPRI Master module and CPRI slave IP blocks.
The reference design uses a transceiver interface (PF_XCVR_ERM) configured in 8b10b mode
running at 4.9152 Gbps data rate, 32-bit PCS fabric interface, and 122.88 MHz reference clock.
The CPRI master module and CPRI IP are configured at Line Rate 5: 4.9152 Gbps with 4 Antenna
Carriers.

The CPRI master module receives the 1Q data from the TX IQ Data Generator and control
information such as Ethernet data, Vendor specific data and antenna carrier control from the
respective pattern generators.

CPRI master module then frames the incoming data and transmits a 32-bit CPRI frame to the
transceiver.

The differential serial data of TX and RX is looped back using an on-board loopback.

The CPRI slave IP receives the incoming frames and segregates the incoming data according to the
CPRI protocol.

The segregated IQ data, Vendor specific data, Ethernet data, and Antenna carrier control
information are written to the respective loop back FIFO’s.

CPRI slave IP then reads the data from loopback FIFO's frames the data and transmits the a 32-bit
CPRI frame to CPRI master module through the transceiver.

The CPRI master module receives the incoming frames, segregates and sends the incoming data to
respective pattern checkers.

Incoming control information is compared with the control data for Vendor specific, Fast Ethernet, IQ
data and Antenna carrier control data. When the data is matched, the respective lock signals are
asserted.

The 1Q data and control information such as Ethernet, Vendor specific and antenna carrier control
lock signals from CPRI Slave IP and Master module along with transceiver RX_Valid and RX_ready
for both the lanes are sent to the UART _interface block.

The UART _interface block forwards these status signal and locks information on its TX interface to
the GUI for display.

Microsemi Proprietary DG0843 Revision 4.0 4
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Figure 3
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Design Implementation

Each CPRI link connects two ports that have asymmetrical functions and roles: a master and a slave.
The CPRI Demo design shows the CPRI point to point link between CPRI REC Master and CPRI RE
Slave.

The Top-Level design includes the following SmartDesign components:

*  CPRI Master Subsystem, page 5
* CPRI Slave Subsystem, page 7
+ Transceiver Subsystem, page 7
*  Mi-V Subsystem, page 8

+ Test Interface, page 9

CPRI Master Subsystem
This sections gives the brief description about the CPRI REC Master.
The CPRI REC Master subsystem consists of the following modules.

*  CPRI Master
« Pattern data generator
«  Pattern checker modules

The following figure shows the implementation of CPRI master subsystem SmartDesign.

CPRI Master Subsystem SmartDesign
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2.3.1.1.1 CPRI Master

When the CPRI master is configured, it receives IQ data, Vendor specific data, Antenna carrier control
data and Ethernet data from the respective pattern generator blocks. It then frames incoming data into
the CPRI frame format at the rate of 4.9152 Gbps and transmits it to the serial lines through the XCVR
interface.

On the receive side, the CPRI master receives the data from the serial lines through the XCVR interface
in the CPRI frame format, it then unpacks the data and sends the received 1Q, VSS, and Ethernet data to
the respective pattern checker block. For more information about register configuration, see Register
Configuration, page 11.

2.31.1.2 Pattern Data Generator
The pattern generator generates the following data:

. 32-bit Ethernet data. The MSB 16-bit are constant and LSB 16-bits are incremental data.
Figure 4+ Ethernet Data Pattern

< 32-bit
16'h5555 Incremental

v

«——16-bit——»l¢——16-bit——>»

*  32-bit VSS data. The MSB 16-bit are constant and the LSB 16-bits are incremental data.
Figure 5+ VSS Data Pattern

< 32-bit
16'hCCCC Incremental

v

«——16-bit———»l¢——16-bit——>»

*  32-bit Antenna Carrier Control data. The MSB 16-bit are constant and the LSB 16-bits are
incremental data.

Figure 6 = Antenna Carrier Data Pattern
< 32-bit
16'hAAAA Incremental

v

+—16-bit——»¢—16-bit————»

. In this demo four antenna carriers are used, each antenna generates 32-bit data. The 1Q data
samples of each Antenna carrier control are fixed at 15-bits. The user-interface width is fixed at 32-
bit, with zero appending on MSB. 15-bit IQ data samples are bit-stuffed in the 32-bit user interface
for each antenna carrier.

Figure 7+ 1Q Data Pattern
< 32-bit

v

0 Q Data 0 I Data

e——15-bit———>» <+«—15-bit———»

2.3.1.1.3 Pattern Checker

The pattern checker has individual pattern checker modules for VSS, Ethernet, Antenna carrier control,
and IQ data, which checks for incremental, data and if the received data is matched, then the respective
lock signals are asserted.

Microsemi Proprietary DG0843 Revision 4.0 6



Common Public Radio Interface Demo

23.1.2

Figure 8 »

2.31.21

2.3.1.2.2

2313

& Microsemi

a AS\MicrocHip company

CPRI Slave Subsystem

The CPRI RE slave subsystem consists of the following modules:

* CPRI Slave
*  Loopback FIFO

The CPRI Slave Subsystem SmartDesign implements CPRI Slave IP interface along with Ethernet, VSS,
Antenna carrier control, and IQ data Loopback FIFO's, as shown in following figure.

CPRI Slave System

|

1 CPRI_Slave 0

Cwn e oetr
e detalo1:]

LOOPBACK_0O

CPRI Slave

CPRI slave IP receives the data from the serial lines through the XCVR interface in the CPRI frame
format. It then unpacks the data and sends the received IQ, VSS, Antenna carrier control, and Ethernet
data to the respective Loopback FIFO's. On the transmit side, CPRI slave IP receives 1Q, VSS, Antenna
carrier control, and Ethernet data from the respective Loopback FIFO's and then frames incoming data
into the CPRI frame format at the rate of 4.9152 Gbps and transmits it to the serial lines through
transceiver interface. For more information on CPRI register configuration, see Register Configuration,
page 11.

For more information about CPRI IP, see Libero Catalog -> Solution-Wireless->Microsemi CPRI User
Guide.

Loopback FIFO

The Loopback FIFO module consists of individual loopback FIFO modules for VSS, Ethernet, Antenna
carrier control, and |Q data, which loopback's the deframed data from the RX interface of CPRI IP to TX
interface of CPRI IP.

Transceiver Subsystem

The transceiver is configured for:

* Two lanes at 122.88 MHz clock- each lane carries 32-bit IQ data
«  32-bit PCS interface

+ Data rate of 4.9152 Gbps
» Lane0 is configured for Master and Lane1 is configured for Slave.

Microsemi Proprietary DG0843 Revision 4.0 7
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Figure 9+ Transceiver Subsystem
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2314 Mi-V Subsystem

The Mi_V_Subsystem SmartDesign operates at 100 MHz. It implements an AHB interface and GP1O
interface. The AHB interface is used to access the CPRI configuration registers, and the GPIO interface
is used to indicate configuration done status, as shown in the following figure.

Figure 10 » Mi-V Subsystem
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For more information about how to build the Mi-V subsystem, see TU0775: PolarFire FPGA: Building a
Mi-V Processor Subsystem Tutorial.
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The address map of Mi-V processor is described in the following table.

Table 2 « System Memory Map

Component Memory Map Description

CoreGPIO 0x60051000 This bus interface is used to access the GPIO's through APB interface.

CPRI Slave IP 0x60060000 This bus interface is used to access CPRI Slave IP configuration registers
through the AHB interface.

CPRI Master module 0x60070000 This bus interface is used to access CPRI Master configuration registers

through the AHB interface.

2.3.1.5 Test Interface

The test interface system contains the UART interface and Inject error module.
The following figure shows the test interface SmartDesign implementations.

Figure 11 » Test Interface SmartDesign
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2.3.1.51 UART Interface
The UART _Interface SmartDesign interfaces Fabric UART logic with the GUI, which displays the lock
signal.

2.3.1.5.2 Inject Error

The Inject error module induces an error in the CPRI frame which propagates through the serial
interface. The presence of an error is validated using a pattern checker module.

Microsemi Proprietary DG0843 Revision 4.0 9
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24 Port Description

The following table describes the input and output ports of the design.

Table 3 « Port Description

Signal Direction Description

RESETN Input External reset

REF_CLK_PAD_P_0 Input This is the differential reference clock generated from the on-board 122.88 MHz

and oscillator.

REF_CLK_PAD_N_01

LANEO_RXD_P and Input Transceiver Receiver differential input of Lane0

LANEO_RXD_N

LANE1_RXD_P and Input Transceiver Receiver differential input Lane1

LANE1_RXD_N

RX Input This is the input signal received by the UART interface from the GUI.

LANEO_TXD_P and Output Transceiver Receiver differential output of Lane0

LANEO_TXD_N

LANE1_TXD_P and Output Transceiver Receiver differential output of Lane1

LANE1_TXD_N

Config_done Output Indicates CPRI master and slave register configuration is completed by Mi-V
processor

VSS_lock Output Indicates the Received Vendor specific data is correct

Ethernet_lock Output Indicates the Received Ethernet data is correct

AxC_Control_lock Output Indicates the received Antenna Control data is correct

AxC_Data_lock Output Indicates the received Antenna |Q data is correct

TX Output This is the output data received by the GUI from the UART interface.

Microsemi Proprietary DG0843 Revision 4.0 10
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2.5 Register Configuration

The CPRI Master module and CPRI Slave IP are connected to the Mi-V processor using an AHB
interface. The base address of CPRI master is 0x60070000 and the base address of CPRI Slave IP is
0x60060000.

Note: Itis recommended to follow the order of register configuration as described in the Table 4, page 11.

The following table describes register configuration and these registers are configured in the SoftConsole
project: mpf dg0843 df\SoftConsole\CPRI config\main.c

Table 4 « Register Configuration

Offset Value Description
0x04 Ox1F TX Interface Sequence Number Register
Line Rate 5: TX_SEQ_NUM: 0x1f
0x08 Ox1F RX Interface Sequence Number Register
Line Rate 5: RX_SEQ_NUM: 0x1f
0x0C 0xBC TX Framer K character Register
TX_Z_0_0_SYNC: 0xBC which is K28.5 character
0x10 0xBC RX Framer K character Register
RX_Z 0 0 _SYNC: 0xBC which is K28.5 character
0x14 0x50 TX Framer D character Register
TX_Z_0_1_SYNC: 0x50 which is D16.2 character
0x18 0x50 RX Framer D character Register
RX_Z 0 1 _SYNC: 0x50 which is D16.2 character
0x1C 0x50 TX Framer D character Register
TX_Z_0_Y_SYNC: 0x50 which is D16.2 character
0x20 0x50 RX Framer D character Register
RX_Z 0_Y_SYNC: 0x50 which is D16.2 character
0x2C 0x14 TX Fast Ethernet pointer register
TX_Z_194_0: 0x14 the Fast Ethernet data to be written from this location
0x24 0x01 TX Protocol Version Register
TX_Z 2_0_SYNC: 0x01, the current version of the IP supports only protocol version 1
0x30 0x14 RX Fast Ethernet pointer register
RX_Z_194_0: 0x14 the Fast Ethernet data to be written from this location
0x100 0xF4240  Start Timer Register
Time out value for L1 Sync state machine
0x104 Ox1FFF HFN Sync Counter Register

Line 5: HFN_COUNT: 1FFF This
value indicates the duration of one CPRI Hyperframe for the selected Line rate

0x00 OxF CPRI Control Register
Enables IQ mapper, demapper, and L1 sync state machine and CPRI IP functionality

Microsemi Proprietary DG0843 Revision 4.0 11
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2.6 Clocking Structure

In this demo design, there are two clock domains. The on-board 122.88 MHz crystal oscillator drives the
XCVR reference clock in 8b10b mode. This generates Lane0/1 RX clock and Lane0/1 TX clock. CPRI
Master system, CPRI Slave Subsystem, and HDL modules use TX and RX clock (122.88 MHz).

The on-chip 160 MHz RC oscillator drives the CCC which generates 100 MHz clock. The
UART _Interface, Mi-V system and the AHB interface of the CPRI Master Subsystem and CPRI Slave
Subsystem use 100 MHz clock. The clock divider generates 40 MHz clock for the XCVR_ERM.

The following figure shows the clocking structure in the reference design.

Figure 12 « Clocking Structure
T Cedvomant Tmesseneoooooo '
! : | Clock Domain 2 !
| | |
| On-Board 122.88-MHz : : 160 MHz !
| Crystal Oscillator ! ! Internal I
! | ! Oscilltor :
|
i v : ; |
| |
| : | Y |
|
! PF_XCVR_REF_CLK i A 4 i PF_CCC !
|
l . CLK Divider ! .
e ittt ! ! 100 MHz !
REFCLK | 1 TTTTTTTTTh T TTTTTT
PF_TX_PLL 40 MHz
CLKS_TO_XCVR
122.88 MHz A 4 Y V12288 MHz
TX_CLK_LO_R RX_CLK_L1_R
o XCVR
RX_CLK_LO_R TX_CLK_L1_R
y A 4 v\
CPRI Master CPRI Slave Miv
Subsystem Test Interface Subsystem Subsystem
A A A A
HCLK UART CLK HCLK HCLK
The following tables describes the clocks used in the demo design.
Table 5+  Clocks
Clock Name Source Frequency
Mi-V Clock CCC_0 100 MHz
RX_CLK_LO_R Transceiver RX recovered clock (Lane0) 122.88 MHz
RX_CLK_L1_R Transceiver RX recovered clock (Lane1) 122.88 MHz
TX CLK LO_ R Transceiver TX PLL clock (Lane0) 122.88 MHz
TX_CLK_L1_R Transceiver TX PLL clock (Lane1) 122.88 MHz
CTRL_CLK CLK Divider 40 MHz

Microsemi Proprietary DG0843 Revision 4.0
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Reset Structure

In the demo design, the reset signal is generated using the Reset_Block module. CoreReset_FF
(CoreReset_PF) module releases active low reset signal of TEST_INTERFACE, Mi-V subsystem and
CPRI Master and Slave subsystem, when PLL_lock output from PF_CCC block, RESETN (External
active low signal) and DEVICE_INIT_DONE signal from INIT_MONITOR block are asserted.

The CoreReset_LO_TX (CoreReset_PF) module releases an active low reset signal of the CPRI Master
subsystem and Test Interface when RESETN (External active low signal) and DEVICE_INIT_DONE
signal from INIT_MONITOR block are asserted.

The CoreReset_L0_RX (CoreReset_PF) module releases an active low reset signals of the CPRI Master
subsystem when RESETN (External active low signal) and DEVICE_INIT_DONE signal from
INIT_MONITOR block are asserted.

The CoreReset_L1_TX (CoreReset_PF) module releases an active low reset signal of the CPRI Slave
subsystem when RESETN (External active low signal) and DEVICE_INIT_DONE signal from
INIT_MONITOR block are asserted.

The CoreReset_L1_RX (CoreReset_PF) module releases an active low reset signal of the CPRI Slaven
subsystem when RESETN (External active low signal) and DEVICE_INIT_DONE signal from
INIT_MONITOR block is asserted.

The INIT_MONITOR releases the active low signal of XCVR_subsystem reset signals (PMA_ARST_N
and PCS_ARST_N) when XCVR_INIT_DONE signal from INIT_MONITOR block is asserted.

DEVICE_INIT_DONE and XCVR_INIT_DONE signals are asserted when the device initialization is
complete. For more information about device initialization, see UG0725: PolarFire FPGA Device Power-
Up and Resets User Guide.

For more information on CoreReset_PF IP core, see CoreReset_PF handbook from the Libero catalog.

Microsemi Proprietary DG0843 Revision 4.0 13
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The following figure shows the reset structure in the demo design.

Figure 13 + Reset Structure

External Resetn

XCVR_INIT_Done

XCVR_SubSystem

PF_CCC PF_INIT_Monitor

PLL_Lock Device_INIT_Done

vy 'y 'y vy 2

CoreReset_FF CoreReset_LO_RX CoreReset_L0_TX CoreReset_L1_RX CoreReset_L1_TX
Fabric_Resetn Resetn_LORX Resetn_LOTX Resetn_L1RX Resetn_L1TX
N—
4 vV i
CPRI_Master_ CPRI_Slave_ -
Test Interface SubSystem SubSystem MiV_SubSystem
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Note:

Figure 14

This chapter describes the Libero design flow, which involves the following processes:

+  Synthesis, page 16

+ Place and Route, page 17

«  Verify Timing, page 18

*  Design and Memory Initialization, page 18
. Generate Bitstream, page 20

*  Run Program Action, page 21

To initialize the TCM in PolarFire using the system controller, a local parameter |_cfg_hard_tcm0_en, in
themiv_rv32 opsrv _cfg pkg.v file should be changed to 1°b1 prior to synthesis. See the 2.7 TCM

section in the MIV_RV32 Handbook.

The following figure shows these options in the Design Flow window.

Libero Design Flow Options

Top Module(roct): TOP_System B 0@ ¢
-

| Tool |—
= b {Create Design
B3 Create SmartDesign
Create HDL
.E Create SmartDesign Testbench
Create HDL Testbench
= # Verify Pre-Synthesized Design
B simulate
» Constraints
#® Manage Constraints
¥ = b Implement Design
B Open Netlist Viewer
v ‘G Synthesize
= b Verify Post-Synthesized Design
+(] Generate Simulation File
B simulate
v H5 Place and Route
= b Verify Post Layout Implementation
v &, Verify Timing
&, Open SmartTime
B+ Verify Power
€% Open SSN Analyzer
= # Configure Hardware
I Programming Connectivity and Interface
& Configure Programmer
& Select Programmer
= # Program Design

v +(] Generate FPGA Array Data
+(’] Configure Design Initialization Data and Memaories
v +] Generate Design Initialization Data

& Configure 1/0 States During JTAG Programming
= Configure Programming Options
@ Configure Security
@ Configure Permanent Locks (OTP)
% Generate Bitstream
& Run PROGRAM Action
= # Program 5Pl Flash Image
> Generate SPI Flash Image
‘o Run PROGRAM_SPI_IMAGE Action
= »# Debug Design
+(] Generate SmartDebug FPGA Array Data
€ SmartDebug Design
el Identify Debug Design
= ¢ Handoff Design for Production
v ¥ Export Bitstream
#) Export FlashPro Express Job
#| Export 5PI Flash Image
+] Export Pin Report

<<

+] Export BSDL
+| Export IBIS Model
=- b Handoff Design for Debugging LJ
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3.1 Synthesis

To synthesis the design, perform the following step:

1. On the Design Flow window, and double-click Synthesize.

When the synthesis is successful, a green tick mark appears next to Synthesize, as shown in Figure 14,
page 15.

The following table lists the resource utilization of the CPRI loopback design. These values may vary
slightly for different Libero runs, settings, and seed values.

Table 6 « Resource Utilization—Synthesis

Type Used Total Percentage
4LUT 31871 299544 10.64
DFF 20214 299544 6.75
I/0 0 1536 0.00
User I/O 11 512 215
-Single-ended 1/O 11 512 215
-Differential-ended 1/O 0 256 0.00
USRAM 12 2772 0.43
LSRAM 97 952 10.19
Math 2 924 0.22
H-Chip Global 10 48 20.83
Local Global 4 1008 0.40
PLL 1 8 12.50
DLL 0 8 0.00
CRN_INT 1 24 417
UJTAG 1 1 100.00
INIT 1 1 100.00
OSC_RC1600 MHz 1 1 100.00
Transceiver Lanes 2 16 12.50
Transceiver PCle 0 2 0.00
TX_PLL 1 1 9.09
XCVR_REF_CLK 1 1 9.09
ICB_CLKINT 4 72 5.56
ICB_CLKDIV 1 24 4.17
ICB_INT 1 12 8.33
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3.2 Place and Route

To place and route the design, TX_PLL, XCVR_REF_CLK, and PF_XCVR, must be configured using the
1/0 Editor. For On-board transceiver loop back, the Lane2 and Lane3 of Quard2 are used, as shown in
the following figure.

Figure 15 « 1/0 Editor Option—XCVR View
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£ @ o fan
av 0
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1.  On the Design Flow window, double-click Place and Route. When place and route is successful, a
green tick mark appears as shown in the following figure.

Figure 16 » Place and Route

Tool

4 )} Create Design

E3 Create SmartDesign

Create HDL

A Create SmartDesign Testbench

Create HDL Testbench

P Verify Pre-Synthesized Design
. Simulate

4 } Constraints

B Manage Constraints

¥ < » Implement Design
B Netlist Viewer
o 3
?L; Place and Route
4 F Ve-rlty Post Layout Implementation

@ Verify Timing

Gl Open SmartTime

i Verify Power

The following table lists the resource utilization after place and route.

Table 7 Resource Utilization—Place and Route

Type Used Total Percentage
4LUT 32019 299544 10.69

DFF 20284 299544 6.77

I/0 Register 0 510 0.00

Logic Elements 38062 299544 12.71

Microsemi Proprietary DG0843 Revision 4.0 17



Libero Design Flow

3.3 Verify Timing

To verify timing, perform the following steps:

1. On the Design Flow window, double-click Verify Timing.
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When the design meets the timing requirements, a green tick mark appears next to Verify Timing.

2. Right-click Verify Timing and select View Report to view the verify timing report and log files in the

Reports tab.
Figure 17 « Verify Timing

Tool
4 b Create Design
E3 Create SmartDesign
Create HDL
A Create SmartDesign Testbench
Create HDL Testbench
4 p Verify Pre-Synthesized Design
. Simulate

[
-
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B Netlist Viewer
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<

<<
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v {3 Verify Timing |

(%, Open SmartTime
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3.4 Design and Memory Initialization

The Configure Design Initialization Data and Memories generates the LSRAM initialization client and
adds it to sSNVM, yPROM, or an external SPI flash, based on the type of non-volatile memory selected. In
this demo, the LSRAM initialization client is stored in the sSNVM.

This process requires the user application executable file (hex file) to initialize the LSRAM blocks on
device power-up. The hex file (CPRI_config.hex) is available in the
DesignFiles Directory\mpf dg0843 df\Libero_ Project folder. When the hex file is

imported, a memory initialization client is generated for LSRAM blocks.
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Figure 18
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To initialize the memory, perform the following steps:

1.

On the Design Flow window, double-click Configure Design Initialization Data and Memories.

The Design and Memory Initialization window opens as shown in the following figure.

Active Synthesis Implementation: synthesis

| Teol

L34

Figure 19

S

»

v

m

v

v

»

& Open SmartTime

B Verify Power

2 Open SSN Analyzer

Configure Hardware
M Programming Connectivity and Interface
& Configure Programmer
& Select Programmer

Program Design
+[] Generate FPGA Array Data
+(] Configure Design Initialization Data and Me...
+[] Generate Design Initialization Data
& Configure I/0 States During JTAG Programming
+ Configure Programming Options
Configure Security
% Generate Bitstream

'S Run PROGRAM Action

» Program SPI Flash Image

‘& Generate SPI Flash Image
‘& Run PROGRAM_SPI_IMAGE Action

Debug Design
+(] Generate SmartDebug FPGA Array Data
€ SmartDebug Design
i Identify Debug Design

Handoff Design for Production
Configure Permanent Locks for Production
#) Export Bitstream
4 Export FlashPro Express Job
4 Export Job Manager Data
4 Export SPI Flash Image
+J Export Pin Report
+(] Export BSDL
+(] Export IBIS Model
+[] Export Design Initialization Data and Memory...
Handoff Design for Debugging
© Export SmartDebug Data

2.

Fabric RAM

Design and Memory Initialization Window

Design Intalzatcn | upRoM | s | SprFash | FabricRaMs

= =T =1

In design initialization, user design blocks such as LSRAM, SRAM, transceivers, and PCle can be initialized as an option using data stored in the non-volatile storage memary.
The initialization data can be stored in PROM, SNVM, or an external SPI Flash.

Follow the below steps to program the initialization data:
1. Set up your fabric RAMS initialization data, if any, using the 'Fabric RAMS' tab
2. Define the storage location of the initialization data

3. Generate the initialization clients

4. Generate or export the bitstream

5. Program the device
 Design inftiszstion spacification

First stage (sNVM)
’7 In the first stage, the initialization sequence de-asserts FABRIC_POR_N.

. d stage (sNVM)

In the second stage, the initialization sequence initializes the PCle and XCVR blocks present in the design.

o |00000000

‘Start address for second stage initization clent: SNVM start page: o

- Thidstage

In the third stage, the initialization sequence initializes the Fabric RAMs present in the design.

To save the i instructions in SNV J h, please use 'Fabric RAMs' tab to make your selection for each RAM client.

ox (00000000
ox (00000000
ox (00000400

h - No-binding Plaintext

|7 Start zddress for =M clients: SNVM start page: 0
I Start zddres: for UPROM cliente:

I Start zddres: for SPI-Flach ciente:

Sp1-Flach Binding: EZ

¥ Broadeast instructions to inftiaiize RAMS to zen's

Time Out (<): 128 -

3000

Custom configuration fle |

Auto Calibraion Time Out (me):

=1

In the Fabric RKMs tab, select the LSRAM client from the list, and then click Edit, as shown in the
following figure.

Azpiy Help
T R
=y Loat tmion confiuration I ot |Lmuamm E=rr==rraa—|
Ivvsistie Memary(Sytes) 2437120 1 ]
LUz=d Memany{Bytes): 182000 I Fiter out Infamed RAMs
Logical Instance Name mp:)fl?m M?f;‘?m Memory Content| Storage Type| Memory Source|
23 | CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_T6/MSC__T7/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
24| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_75/MSC__80/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
25| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_81/MSC__82/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
26 | CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_j_52/MSC_i_85/MSC_i_86/MSC_i_87/MSC__88/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
27| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_j_52/MSC_i_85,/MSC_i_86/MSC_i_91/MSC_j_02/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
28 | CPRI_SLAVE SubSystem_0/CPRI_Slave_D/MSC_j_52/MSC_i_85/MSC_i_86/MSC_j_93/MSC__0d/ram_block{31:0] 512430 512:30 Ne content SNV Synthesis
29| CPRI_SLAVE SubSystem_0/CPR| Slave_D/MSC_i_52/MSC_i_85/MSC_i_86/MSC_j_95/MSC__06/ram_block{31:0] 512630 512:30 Ne content sNVM Synthesis
— 30| CPRLSLAVE SubSystem 0/CPR Slave O/MSC i S2/MSC_i_35/MSCi 99/cpri aigned data in regd[3101 432 432 Noconten: | sNVM Synihesis
—— sseara | || | 31] cPRUSLAVE Subsystem 0/Fbric Loopback Subsystem 0/AxC_CTRL Joopback 0/u buf Ipbk/BUFFER LPBCK 0 102432 1024532 Noconten: | sNVM Configurator
2352 | || | 35 | CoRI_SLAVE SubSystem_0/Fabric_Loopback Subsystem 0/AxC_DATA Joopback /genbiki0]_but Ipbi/BUFFER LPBCK 0 102432 1024532 Noconten: | sNVM Configurator
P | {55 contsuave subsyssem 0sbec Loapbeck Submstem 074 DATA locaback Digenielf]a b Itk 3UFFER LPECK 0 102432 1024532 Noconten: | sNVM Configurator
34 CPRLSLAVE SubSystem_0/Fabric_Loopback Subsystem 0/AxC_DATA Joopback Digenblkll2]u_buft Ipbk/BUFFER LPBCK 0 102432 1024532 Noconten: | sNVM Configurator
35 CPRLSLAVE SubSystem_0/Fabric_Loopback Subsystem {/AxC_DATA Joopback Digenblk1[3].u_buft Ipbk/BUFFER LPBCK 0 102432 1024532 Noconten: | sNVM Configurator
36 | CPRI_SLAVE_SubSystem_0/Fabric_Loopback_Subsystem_0/Ethernet_loopback_0Vu_buff_Ipbk/BUFFER_LPECK D 1024532 1024232 No content sNVM Configurator
37 | CPRI_SLAVE_SubSystem_0/Fabric_Loopback_Subsystem_0/V5S_loopback_0/u_buff_lpbk/BUFFER_LPBCK 0 1024x32 1024232 No content SNVM Configurator
39 | MIV_SubSystem_0/MIV_RV32_C0_0/MIV_RV32Z_C0_0/u_opsrv_D/u_core_0/u_axpipe_0/gen_gpr_ram.u_gpr_0/gen_gpru_gpr_array_0/mem[31:.0] | 3232 3232 No content sNVM Synthesis
[ | Us=d space 40 | MiIV_SubSystem_0/MIV_RV32_C0_0/MIV_RV3Z_C0_0/u_opsrv_D/u_core_0/u_axpipe_0/gen_gpr_ram.u_gpr_0/gen_gpru_gpr_array_0/mem_1[31:0] | 3232 3232 No content sNVM Synthesis
= e 41 | TEST_NTERFACE_0/CDC_Master_FIFO_0/CDC_Master_FIFO_0/genbik24.Ul_ram_wrapper_1/L1_asyncnonpips 1024x9 10249 No content sNVM Cenfigurator

In the Edit Fabric RAM Initialization Client dialog box, select the Content from file option, and

locate the CPRI_config.hex file from
DesignFiles directory\mpf dg0843 df\Libero Project folder and then click OK, as
shown in the following figure.

Microsemi Proprietary DG0843 Revision 4.0

19



Libero Design Flow

Figure 20

Edit Fabric RAM Initialization Client

@ Edit Fabric RAM Initialization Client

Client name: | MiV_SubSystem_0/LSRAM_exe_0
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Physical Name: }1_EXE_PF_T PSRAM_AHB_AXI_0_PF_TPSRAM_R24C0O/INST_RAMI1K20_IP

— RAM Initialization Options

¢ TInitialized Content from Synthesis

& Content from file: |CPRL config.hex

]

Imported Memory file location : CPRI_config.hex

" Content filled with 0s

" No content (client is a placeholder and will not be programmed)

Optimize for: © High Speed & Low power

Storage Type IsNVM 'l

o | x|

Close
.
4. Click Apply as shown in the following figure.
Figure 21 » Design Initialization
S A
I Agply I Dirzard | Heip
e  Cmts
e Lot Smsign configurstion | it |hmddmm [oree st Gttt ]
rvailabie Memary B tes). 2437120
LUz=d Memany{Bytes): 182000 I Fiter out Infamed RAMs
Tt e Logical Instance Name mp:)fl?m M?f;‘?m Memory Content| Storage Type| Memory Source|
23 | CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_T6/MSC__T7/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
24| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_75/MSC__80/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
25| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_i_52/MSC_i_69/MSC_i_70/MSC_i_81/MSC__82/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
26 | CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_j_52/MSC_i_85/MSC_i_86/MSC_i_87/MSC__88/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
27| CPRI_SLAVE SubSystem_0/CPR|_Slave_D/MSC_j_52/MSC_i_85,/MSC_i_86/MSC_i_91/MSC_j_02/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
28 | CPRI_SLAVE SubSystem_0/CPRI_Slave_D/MSC_j_52/MSC_i_85/MSC_i_86/MSC_j_93/MSC__0d/ram_block{31:0] 512430 512430 Mo contant MV Synthesis
= IF'E'E.E:I:PF":E::= 29| CPRI_SLAVE SubSystem_0/CPR| Slave_D/MSC_i_52/MSC_i_85/MSC_i_86/MSC_j_95/MSC__06/ram_block{31:0] 512630 512:30 Mo content sMVM Synthesis
. 30| CPRISLAVE SubSystem_0/CPRI Slave_D/MSC i S2/MSC_i_85/MSC_i 99/cori_aligned_data in reg3 3101 %3z 432 Ne content SNVM Synthesis
valatie Memany(Bptes) i 31| CPRLSLAVE SubSystem_0/Fabric Loopback Subsystem 0/AxC_CTRL Joopback 0/u_buff lobk/BUFFER_ LPECK 0 102432 1024:32 Ne content SNVM Configurator
Uy R 32 | CPRISLAVE SubSystem_0/Fabric_Loopback_Subsystem_0/AxC_DATA loopback Dvgenbiki[0].u_buff Ipbk/SUFFER_LPBCK 0 1024532 1024532 Mo content sNYM Configurator
e = 33| CPRLSLAVE SubSystem_0/Fabric Loopback Subsystem_0/AxC_DATA loopback Digenbik1[1].u_buff Ipbk/BUFFER LPBCK 0 102432 1024:32 Ne content SNVM Configurator
34| CPRISLAVE SubSystem 0/Fabric Loopback Subsystem_0/AxC_DATA loopback Digenbik1[2].u_buff Ipbk/BUFFER LPBCK 0 102432 1024:32 Ne content SNVM Configurator
35 | CPRI_SLAVE_SubSystem_0/Fabric_Loopback_Subsystem_0/AxC_DATA_loopback_0/genbik[3].u_buff_Ipbik/BUFFER_LPECK D 1024532 102432 Mo content sHVM Configurator
36 | CPRI_SLAVE_SubSystem_0/Fabric_Loopback_Subsystem_0/Ethernet_loopback_0Vu_buff_Ipbk/BUFFER_LPECK D 1024532 102432 Mo content sHVM Configurator
37 | CPRI_SLAVE_SubSystem_0/Fabric_Loopback_Subsystem_0/V5S_loopback_0/u_buff_lpbk/BUFFER_LPBCK 0 1024x32 1024232 Mo contant sHVM Configurator
) \ tem.u_ops ram. 101 Synthesis
39 | MIV_SubSystem_0/MIV_RV32_C0_0/MIV_RV32Z_C0_0/u_opsrv_D/u_core_0/u_axpipe_0/gen_gpr_ram.u_gpr_0/gen_gpru_gpr_array_0/mem[31:.0] | 3232 3232 Mo contant MM Synthesis
= tk:::r:: 40 | MiIV_SubSystem_0/MIV_RV32_C0_0/MIV_RV3Z_C0_0/u_opsrv_D/u_core_0/u_axpipe_0/gen_gpr_ram.u_gpr_0/gen_gpru_gpr_array_0/mem_1[31:0] | 3232 3232 Mo contant MM Synthesis
41 | TEST_NTERFACE_0/CDC_Master_FIFO_0/CDC_Master_FIFO_0/genbik24.Ul_ram_wrapper_1/L1_asyncnonpips 1024x9 102429 Mo contant MM Configurator

3.5

5. To generate design initialization data, click Generate Initialization Data on the Design Flow window.
After successful generation of the Initialization data, a green tick mark appears next to Generate

Initialization Data option as shown in the Figure 21, page 20.

Generate Bitstream

To generate bitstream, perform the following steps:

1. On the Design Flow window, double-click Generate Bitstream.
When the bitstream is successfully generated, a green tick mark appears next to Generate

Bitstream, as shown in Figure 14, page 15.

2. Right-click Generate Bitstream and select View Report to view the corresponding log file in the

Reports tab.
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3.6 Run Program Action

To program the PolarFire device, perform the following steps.

1. Ensure that the jumper settings on the board are as listed in the following table.

Table 8 » PolarFire Evaluation Board Jumper Settings

Jumper Description

J18, J19, J20, J21, and J22  Short pin 2 and 3 for programming the PolarFire FPGA through FTDI

J28 Short the pin 2 and 3 for programming through the on-board FlashPro5

J4 Short pin 1 and 2 for manual power switching using SW3

J12 Short pin 3and 4 for 2.5V

J46 Short pin 1 and 2 for routing 125 MHz differential clock oscillator output to the side.

Open pin 1 and 2 for routing 122.88 MHz differential clock oscillator to the line side.

2. Connect the power supply cable to the J9 connector.
3. Connect the USB cable from the host PC to the J5 (FTDI port).
4. Power on the board using the SW3 slide switch.

The following figure shows the board setup.

Fiure 22 Polarire Evaluation Board Set

DU —

r) =
000000000
000000000

-------

5. On the Design Flow window, double-click Run PROGRAM Action.

The device is successfully programmed and a green tick mark appears next to Run PROGRAM Action
as shown in Figure 14, page 15. LED 4 is asserted once the device is programmed.
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4 Running the Demo

This section describes how to install and use the CPRI Demo application Graphic User Interface (GUI).
The PolarFire CPRI demo application is a simple GUI that runs on the host PC to communicate with the
PolarFire Device.

Installing CPRI Demo Application
To install CPRI demo application, perform the following steps:

1. Install the GUI (setup.exe) from the following design files folder mpf dg0843 df/GUI

The following steps describes how to install and use the GUI to run the CPRI Loopback demo. The
following procedure assumes that:

+  The PolarFire Evaluation board is connected.
*  The PolarFire FPGA is programmed with the CPRI Loopback design.

To run the CPRI Loopback demo, perform the following steps:

Extract the contents of the mpf dg0843 df.zip file.

Fromthe mpf dg0843 df\GUI Installer folder, double-click the setup.exe file.

Follow the instructions displayed on the installation wizard.

Atfter successful installation, CPRI_GUI appears on the Start menu of the host PC desktop.
From the Start menu, click CPRI_GUI to launch the application.

The GUI detects the COM port number and automatically connects to the board, as shown in the
following figure. COM Port numbers may vary.

ok wh=

Figure 23 »+ Selecting COM Port and Connecting

< CPRI_Demo_V2.2 - >

& Microsemi CPRI Demo

Master
v/ Serial Link 9 Ethernet Status
v RxValid K AxC Control Status
K Vss status @ @ @ P AxC Data Status
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7. Click Start. The data is generated and framed using the CPRI master module and sent over the
serial transmit link. It is then received by the receiver, and CPRI slave IP unpacks the data and
loopbacks the data to the CPRI master module. The checker in the Master system checks the
incoming data for any errors. The status can be monitored using the status signals on the GUI at any
time, as shown in the following figure. The following are the status signals:

. Serial Link: Indicates transceiver link status

. Rx Valid: Indicates if the transmitter and receiver data are locked

* VSS status: Indicates the received VSS data is valid.

. Ethernet status: Indicates the received Ethernet data is valid.

*  AxC Control status: Indicates the received Antenna carrier control data is valid.
* AxC Data Status: Indicates the received Antenna carrier data is valid.

The following shows the status signals.The LED4, LED5, LED6, LED7, LEDS8, LED9, LED10, and LED11
is asserted at the same time.

Figure 24 » Master Checker Status—Pass

< CPRI_Demo_V2.2 - >

& Microsemi CPRI Demo

Master
v/ Serial Link v/ Ethernet Status
v/ RxValid v AxC Control Status
v/ VSS Status J ) AxC Data Status

Payload Error QlbELIC L
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8. Click Payload Error to induce error in VSS data, Ethernet data, Antenna carrier control data and
Antenna carrier Data. Observe the error status of master as shown following figure. The LEDS5,
LED®6, LED7, LEDS, LED9, LED10, and LED11 is deasserted at the same time.

Figure 25 » Payload Error Enabled—Master

< CPRI_Demo_V2.2 - >

& Microsemi CPRI Demo

o e o I

Master
v/ Serial Link K Ethernet Status
W RxValid K AxC Control Status
K Vss status @ ® P P AxC Data Status

Payload Error Enabled

9. Disable Payload Error to stop generating an error and observe that the Serial Link, Rx Valid, and all
the status signals of master turn green, as shown in the following figure. When the error is cleared,
the LED5 to LED11 is asserted at the same time.

Figure 26 » Payload Error Disabled—Master

< CPRI_Demo_V2.2 - >

& Microsemi CPRI Demo

o e o I

Master
v/ Serial Link v/ Ethernet Status
W RxValid W AxC Control Status
v/ VSS Status J J AxC Data Status

Payload Error EEIdCD

The CPRI demo is successfully run.
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5 Appendix 1: Programming the Device Using
FlashPro Express

This chapter describes how to program the PolarFire device with the Job programming file using a
FlashPro programmer. The default location of the .stp file is: mpf dg0843 df\Programming_ Job

To program the PolarFire device using FlashPro Express, perform the following steps:

1. Ensure that the jumper settings on the board are the same as listed in Table 8, page 21.
Note: The power supply switch must be switched off while making the jumper connections.

Connect the power supply cable to the J9 connector on the board.

Connect the USB cable from the Host PC to the J5 (FTDI port) on the board.

Power on the board using the SW3 slide switch.

On the host PC, launch the FlashPro Express software.

Click New or select New Job Project from FlashPro Express Job from Project menu to create a new
job project, as shown in the following figure.

o0k wn

Figure 27 « FlashPro Express Job Project

@ FlashPro Express

Project Edit View Programmer Help

Job Projects

Newi...
Open... X Close Job Project
I Savelob Project Ctrl+Shift+A

@ FlashPro Express

Project | Edit View Programmer Help

J New Job Project from FlashPro Express Job Ctrl+N
r“ Open Job Project Ctrl+O

Recent Projects
or Set Log File

Export Log File
Preferences...

Execute Script Ctrl+U
Export Script File...

Recent Projects L4

Exit Ctrl+Q

7. Enter the following in the New Job Project from FlashPro Express Job dialog box:

«  Programming job file: Click Browse, and navigate to the location where the .job file is located and
select the file. The default location is: <download_folder>\mpf_dg0843_df\Programming_Job.

»  FlashPro Express job project location: Click Browse and navigate to the location where you want to
save the project.
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Figure 28 « New Job Project from FlashPro Express Job
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@ Mew Job Project from FlashPro Express Job

Programming job file:

| D:\mpf_dg0843_df\Programming_Job\CPRI _Line_Rate_5.job

FlashPro Express job project name:
© PRI Line Rate 5

FlashPro Express job project location:

Browse...

| D:\mpf_dg0843_df

Help

OK

X
ey

| Cancel |

8. Click OK. The required programming file is selected and ready to be programmed in the device.
9. The FlashPro Express window appears as shown in the following figure. Confirm that a programmer
number appears in the Programmer field. If it does not, confirm the board connections and click

Refresh/Rescan Programmers.
Figure 29 « Programming the Device

E FlashPro Express D:\mpf_dg0843_df\CPRI_Line_Rate_5\CPRI_Line_Rate_5.pro - JTAG Programming Interface

Project Edit View Programmer Help

Refresh/Rescan Programmers

0 weors &

& ToO ™A

j O ¥ [e2003G80 IDLE IDLE

Programmer

PROGRAM B

RUN IDLE

Log

[E]messages @ Errors i, Warnings @ Info

8 x

Exported log file D:\mpf_dg0843_df\CPRI_Line_Rate_ S5\CPRI_Line_Rate_5.log.
Software Version: 12.600.0.14

PPD file 'D:\mpf_dg0843_df\CPRI_Line Rate_S\top.ppd' has been loaded suecessfully.
DESIGN : top; CHECKRSUM : O3R8; PDB_VERSION : 1.0

Embedded FlashProS programmer detected.

programmer 'E2003GSCVO’ : FlashProS

Opened 'D:\mpf_dg0843_df\CPRI_Line Rate_ S\CPRI_Line_Rate_5.pro'

Ll
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10. Click RUN. When the device is programmed successfully, a RUN PASSED status is displayed as
shown in the following figure.
Figure 30 » FlashPro Express—RUN PASSED

FlashPro Express D:\mpf_dg0843_df\CPRI_Line_Rate_$\CPRI_Line_Rate_3.pro - JTAG Programming Interface

Project Edit View Programmer Help
Refresh/Rescan Programmers

Programmer

©® wrraooTs 0§

< TDO ™S

o] @ e I E——

T
o 1PROGRAMMER@)PASSED

Log 3 x

[E] Messages @ Errors b Warnings @ Info

programmer 'E2003G%CV0O' : device '"MPF300T3' : EXFORT EOB component bitstream digest[256] = j
£a93e4608£80£7dda77546belb47a29£07b02823ab3447£305ca52a4874b355
programmer 'E2003G%CVO' : device 'MPF300TS"' :
programmer 'E2003G9CVO" : device 'MPF300T3"' : EXPORT DSN[128] = €B82d3€eldclas24a494d63flbedeB0d3
programmer 'E2003GSCVO' : device 'MPF300TS' :
programmer 'E2003G9CVO" : device 'MPF300T3' : Finished: Tue Oct 22 13:46:41 2019 (Elapsed time 00:01:45)
programmer 'E2003G9CVO" : device "MPF300TS' : Executing action PROGRAM PASSED.
programmer ‘E2003G%CVO' : Chain programming PASSED.

J

cChain Programming Finished: Tue Oct 22 13:46:41 2019 (Elapsed time 00:01:45)

@e-o-e-o0-90-o0o

11. Close FlashPro Express or in the Project tab, click Exit.
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6 Appendix 2: Running the TCL Script

TCL scripts are provided in the design files folder under directory TCL_Scripts. If required, the design
flow can be reproduced from Design Implementation till generation of job file.

To run the TCL, follow the steps below:

1. Launch the Libero software

2. Select Project > Execute Script....

3. Click Browse and select script.tcl from the downloaded TCL_Scripts directory.
4. Click Run.

After successful execution of TCL script, Libero project is created within TCL_Scripts directory.
For more information about TCL scripts, refer to mpf_dg0843_df/TCL_Scripts/readme.txt.

Refer to Libero® SoC TCL Command Reference Guide for more details on TCL commands. Contact
Technical Support for any queries encountered when running the TCL script.

Microsemi Proprietary DG0843 Revision 4.0 28


https://www.microsemi.com/document-portal/doc_download/1245481-libero-soc-v12-6-tcl-commands-reference-guide-for-smartfusion2-igloo2-and-rtg4

Appendix 3: References

& Microsemi

a @MI:HGCHIP company

7 Appendix 3: References

This section lists the documents that provide more information about the concepts and features covered
in this demo guide.

For more information about PolarFire transceiver blocks, see UG0677: PolarFire FPGA Transceiver
User Guide.

For more information about Libero, ModelSim, and Synplify, refer Microsemi Libero SoC webpage.
For more information about CPRI IP, see Libero Catalog -> Solution-Wireless->Microsemi CPRI
User Guide

For more information about PolarFire Evaluation kit, see UG0747: PolarFire FPGA Evaluation Kit
User Guide

For more information about Power-Up and Reset, see UG0725: PolarFire FPGA Device Power-Up
and Resets User Guide

For more information about the CoreJTAGDEBUG IP core, see CoreJTAGDebug_HB.pdf from
Libero->Catalog.

For more information about the MIV_RV32 IP core, see MIV_RV32 Handbook from the Libero SoC
Catalog.

For more information about the CoreAHBtoAPB3 IP core, see CoreAHBtoAPB3_HB.pdf.

For more information about the CoreUARTapb IP core, see CoreUARTapb_HB.pdf.

For more information about the CoreAHBLite IP core, see CoreAHBLite HB.pdf.

For more information about the CoreAPB3 IP core, see CoreAPB3_HB.pdf.

For more information about the CoreGPIO IP core, see CoreGPIO_HB.pdf
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